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Abstract 

The surface geology of Taylor Valley records information about the long- and short-term             
geologic history of the region. It may be possible to extract some of this information using only                 
remote-sensed LiDAR-derived elevation datasets. This study seeks to determine whether a map            
comprised of soil units created using only elevation data and surface roughness calculations             
can reproduce previous mapping results based on in-situ observation and soil pedons. We find              
that within Taylor Valley, till deposit distribution can be well-modelled primarily as a function of               
elevation, modified by surface roughness. 
_____________________________________________________________________________ 
 
1. Introduction 
 
The McMurdo Dry Valleys (MDV) are a series of valleys located along the eastern flank of the                 
Transantarctic mountains. Containing 4500 km​2 ​of exposed bedrock and soils, the MDV are the              
largest ice-free region of Antarctica. Taylor Valley (TV), located in the central MDV, is one of the                 
larger and most well-studied valleys of the region. Like the rest of the MDV, Taylor Valley is                 
considered a cold desert with a climate characterized by extreme lack of precipitation, low relative               
humidity, high wind speeds, and freezing temperatures. The landscape of TV consists of bare              
mountain slopes containing extensive permafrost soils cut by piedmont glaciers, ephemeral streams,            
and perennially ice-covered lakes. To the East, Taylor valley is plugged by an outlet glacier of the                 
East Antarctic Ice Sheet, and opens to the Ross Sea to the West.  
 

The lack of vascular plants in Taylor Valley means that the distribution of soil properties,               
permafrost, and ground-ice features within the valley are controlled by geologic processes and not              
the distribution of biota. Therefore, the surface geology of Taylor Valley preserves information             
regarding the long-term history of the Antarctic ice sheets and climate, and records short term               
history of hydraulic and thermokarst geomorphic processes at work in the valley.  

 
Taylor Valley soils have been mapped by Bockheim et al 2008 as distinct till units which are                 

interpreted to record deposition by several successive past glaciation events. A testable hypothesis             
results from this interpretation: because glaciations cut through and erode older material as they              
advance, till units should correspond to topography, with older units occupying higher elevations.             
Additionally, three broad types of permafrost exist in TV: ice-cemented permafrost, dry-frozen            
permafrost, and ice-cored permafrost. Different permafrost types allow for the formation of            
different periglacial features such as contraction-crack polygons, water tracks, and ice-cored           



 

moraines. These features affect the roughness of the TV surface, and therefore the distribution of               
surface roughness properties may correspond to soil type.  
 

Based on the assumption that soils of different glacial origins and modern textures can be               
categorized by elevation and surface roughness, by using elevation data and calculated standard             
deviation of elevation values for Taylor Valley, this study seeks to create a map composed of seven                 
till units corresponding to the seven till units mapped by Bockheim et al 2008, and to test how well                   
the spatial-extent of calculated units agree with mapped units. 

 
2. Methods 
 
2.1 Data acquisition 
 
Three data sets were utilized to perform this study. 
 

First, a map produced by Bockheim et al 2008, which shows the distribution of glacial               
deposits in Taylor valley, was captured as a PNG image (Figure 1). The captured image did not                 
originally contain geographic coordinates. 
 

Second, a single tile, ​x+0300000y-1350000, ​of the Landsat Image Mosaic of Antarctica            
(LIMA) covering the extent of the study area was downloaded from ​http://lima.usgs.gov/​. LIMA             
provides geometrically accurate and high resolution (15 m by 15 m) satellite images of Antarctica               
(Figure 2). The LIMA tile was useful for georeferencing points on Bockheim maps to recognizable               
features and for interpreting terrain analyses in Taylor Valley. Metadata for the LIMA tile is available                
at ​http://tdds.cr.usgs.gov/metadata/lima/RGBREF/RGBREF_x+0300000y-1350000.htm​.  
 

Finally, a high-resolution (1 m by 1 m) digital elevation model (DEM) produced by Fountain               
et al in 2014 from airborne LiDAR scans was utilized for surface analyses. The LiDAR coverage                
includes surveys of 8 regions in and around the MDV. 
 
 

http://lima.usgs.gov/
http://tdds.cr.usgs.gov/metadata/lima/RGBREF/RGBREF_x+0300000y-1350000.htm


 

 
Figure 1. ​PDF image of Bockheim et al 2008 used to digitize map units. 

 
 



 

  
Figure 2. ​Landsat Image Mosaic of Antarctica (LIMA) tile ​x+0300000y-1350000​ covers the 
extent of the Central MDV.  

 
2.2 Digitizing Bockheim 2008 maps 
 
In order to compare terrain analysis results to previous mapping efforts, Figures produced by              
Bockheim et al were georeferenced and digitized within Arcmap. To georeference, spatially            
referenced Landsat mosaics were loaded into ArcMap. The spatial reference for the mosaics is WGS               
1984 Arctic Polar Stereographic. Using the tools accessible with the georeferencing toolbar in             
ArcMap, a total of 6 control points were used to georeference the Bockheim glacial deposit map                
with respect to the Landsat images with an RMS error of 63.7. The intersections of lake and glacier                  
margins served as easily identifiable point locations for georeferencing. The low-resolution of the             
PDF map image make more accurate georeferencing difficult. After establishing sufficient control            
points, the Bockheim figure was rectified and saved as a spatially referenced file (Fig. 3). 



 

 
A geodatabase was created to store feature data created while digitizing. Two feature classes              

were created, an outline polygon (“Study Area”) to capture the extent of Taylor Valley and a                
contacts line (“Contacts”) to digitize glacial deposit contacts. Domains containing unit names were             
created and attached to the feature classes (Figure 4). Eight unit names were created to symbolize                
the eight distinct units mapped by Bockheim et al: “Ross Drift”, ”Undifferentiated”, ”Taylor-II”,             
”Taylor-III”, ”Taylor-IV”, ”Alpine-III”, ”Glacier Ice”, and ”Lake”. 
 

Before converting “Contacts” into polygons representing geologic units, the “Contacts”          
feature class was checked to ensure it obeyed topography using the Topology Wizard. Contacts were               
checked for overlaps, dangles, and self-intersection. Point and line errors were corrected using the              
“Fix Topology Error” tool. Results of error inspection and correction are shown in Figure 5. 

 
Map unit polygons were created from the contour feature class using the “Feature to              

Polygon Tool”. To symbolize and label glacial deposit units, a new text field named “Name” was                
created for the Glacial Deposits feature class. Names were assigned to the attribute table of each                
polygon. Map units were symbolized to resemble Bockheim et al 2008. The final steps of map unit                 
digitization are shown in Figure 6. 

 
2.3 Elevation & surface roughness  
 
The original 2014 DEM covers areas beyond the Taylor Valley study area. In order to reduce file                 
size and computation time, the original DEM was cut using the “Extract by Mask” tool to the                 
“Study Area” polygon to produce a clipped DEM file named “2014all_clip” (Figure 7).  

 
Surface roughness (STD​elev​) was calculated using “Spatial Analyst Tools” > “Neighborhood”           

> “Focal Statistics,” with a 3 meter by 3 meter moving window to calculate standard deviation of                 
elevation over the entire Taylor Valley DEM (Figure 8). Standard deviation of elevation provides an               
easily-calculated measure of surface roughness (Grohmann, 2011). Periglacial processes produce          
small landforms, therefore a small window was chosen in order for local relief (small breaks in slope)                 
to be recorded with high roughness values.  

 
To create a map broken into eight categories based on elevation and roughness, the DEM               

and STD​elev ​files were reclassified into four categories using the “Spatial Analyst” > “Reclass” >               
“Reclassify” > tool. Category boundaries for each raster file were determined by natural jenks in               
their respective data histograms. The operation of this tool resulted in layers whose cells contain a                
value of either 1 (low elevation or low roughness), 2, 3, or 4 (high elevation or high roughness)                  
(Figure 12. A, B).  

 



 

The reclassified DEM and STD​elev layers were then added together using “Spatial Analyst” >              
“Map Algebra” > “Raster Calculator”. This operation produced a new raster file containing seven              
categories of value 2 through 8 (Figure 12. C). Low values now correspond to lower, smoother                
surfaces while higher values correspond to higher, rougher surfaces. 

 
To see whether the spatial distribution of the seven categories based on elevation +              

roughness values correspond to the spatial distribution of Bockheim’s seven mapped glacial till             
units, the digitized “Glacial Deposits” polygon feature class layer was reclassified. To accomplish             
this, first the polygon feature class layer was converted into a shapefile using the “Data Management                
Tools” > “Generalization” > “Dissolve” tool. Then, so that the unit polygons could eventually be               
assigned values for map algebra, this shapefile was converted into a raster file using the “Conversion                
Tools” > “To Raster” > “Feature to Raster” tool. Next, the map units were reclassified using the                 
“Reclassify” tool to new ranks corresponding the categories calculated in the ‘elevation + roughness’              
layer. Table 1 shows the conversions used to convert unit ​values​ in the ‘Glacial Units” raster into new                  
unit ​ranks​ in the reclassified raster. Conversions were determined by considering each unit’s position              
in the valley. Down-valley, lower elevation units were assigned lower ranks than up-valley, higher              
elevation units (Figure 12. D, E). 
 

Table 1.​ Glacial Deposits Reclassification 

Name Value Rank 

Ross_Drift 5 2 

Undifferentiated 9 3 

Taylor_II 6 4 

Taylor_III 7 5 

Taylor_IV 8 6 

Alpine_III 2 7 

Lake 4 8 

Glacier_Ice 3 8 

Older Alpine or non-till 1 8 

 
In order to compare only the soil regions contained in the ‘elevation +roughness’ layer and               

the ‘reclassified units’ layer, areas corresponding to glacier ice were masked out of both rasters using                
the “Extract by Mask” tool. Finally, to calculate the difference between the masked ‘elevation +               
roughness’ and ‘reclassified units’ layers, the absolute value of the difference between the layers was               
calculated using the “Raster Calculator” tool (Figure 14).  



 

 
3. Results 
 
3.1 Digitized Bockheim 2008 map 
 
The digitized Bockheim 2008 map is shown in Figure 9. The map delineates seven distinct till units                 
as well as the extent of lakes and glacier ice within Taylor Valley. The PNG image of the map did                    
not provide the resolution necessary to digitize to the full accuracy allowed by the LIMA tile. Even                 
with careful control point selection, the final digitized version of the Bockheim map contained a               
significant RMS error which can be seen as offsets between digitized contacts and features in the                
LIMA tile at scales of hundreds of meters in many cases (Figure 10). These discrepancies inevitably                
cause errors in terrain calculations, however the errors are not significant enough to invalidate              
regional-scale analyses. 
 

Figure 10. ​Examples of offset geologic contacts (red ellipse) between Lake 
Bonney and Taylor-II till in the western reach of Taylor valley. 

 
  



 

 

Figure 9. ​Digitized map of glacial deposits and landscape features in Taylor Valley compiled from 
Bockheim et al 2008 superposed over LIMA tile of the Central MDV and projected to the WGS 
1984 USGS Transantarctic Mountains coordinate system. Besides glacier and lake ice, the map 
categorizes seven distinct till units. Taylor Valley has experienced three kinds of glaciations in the 
past ~2 billion years: the eastward advance of Taylor Glacier, the north/south advance of alpine 
glaciers, and the westward advance of the grounded Ross Sea Shelf. Each advance deposits a 
distinct layer of till resulting in the mosaic of units seen above. With minimal fluvial or biotic 
activity in the valley, these till units remain largely undisturbed and thus should correspond to 
elevation. Cryoturbation and periglacial processes acting differentially across the valley according 
to the presence of ground ice and climatic variations may result in surface textures diagnostic of 
certain tills. 

 
 
3.2 Terrain roughness 
 
The results of STD​elev calculations are shown in Figure 11. The fine resolution of the DEM allowed                 
for the capture of local-scale differences in terrain elevation. With this calculation, valley walls and               



 

glacier margins exhibit the highest roughness values. There is significant spatial variability in STD​elev              
across till units. Down-valley till units appear to be less rough than up-valley till units. The elevation                 
information contained in the DEM shown in Figure 11 B seems to correlate well with unit contacts.                 
Additionally, it appears that some correlation between Bockheim 2008 geologic contacts and            
roughness values may also exist. 
 

Figure 11. ​Elevation and elevation-derived data within Taylor Valley overlaid upon LIMA tile of 
the Central MDV and projected to the WGS 1984 USGS Transantarctic Mountains coordinate 
system. (A) DEM-Derived Hillshade depicting regional-scale geomorphology of the valley. (B) 
Digital elevation model of Taylor Valley with superposed geologic unit contacts. (C) Standard 
deviation of elevation (STD​elev​) calculated using a 3 m by 3 m window with superposed unit 
contacts. Brighter colors indicate a higher roughness value. 

 
3.3 Surface elevation and roughness as a proxy for surface geology 
 
By reclassifying the DEM elevation values and surface roughness values into 4 ranks, and adding the                
results together, a new map containing elevation and roughness information parsed into seven ranks              



 

was obtained (Figure 12. A, B, C). To test whether the seven calculated units correspond               
meaningfully to the seven till deposits mapped by Bockheim 2008, the digitized till units were               
similarly reclassified into seven ranks according to their position in the valley (Figure 12. D, E). After                 
masking out glacier and lake ice, by subtracting the two rasters and taking the absolute value of their                  
difference, a final comparison map quantifying how closely the proxy units agree with the mapped               
units is obtained (Figure 12. F). Higher values correspond to greater differences. Values can be               
considered a measure of error in the proxy map’s ability to predict till units. Table 2. shows error                  
statistics for individual till units. Some units are better predicted by the surface calculations (Ross               
Drift) than others (Alpine-III). Variation of difference within the units remains fairly constant across              
all units. There does not seem to be a correlation between higher average error and higher variation                 
of error within units (Figure 13).  
 
 
 
 
 
 
 



 

Figure 12. ​Maps used to determine the accuracy of using elevation and surface roughness as a 
proxy for till units. (A) DEM raster model and (B) STD​elev​ raster model of Taylor Valley, each 
reclassified to 4 values. (C) Proxy surface geology map of Taylor Valley derived from the sum of 
(A)​  and ​(B) ​ with glacier ice masked out​. ​ The resulting seven values contain elevation and 
roughness information and are intended to work as a proxy for Bockheim till units. (D) Geologic 
units after Bockheim et al 2008. (E) Geologic units reclassified to seven map values corresponding 
to each unit’s position in the valley with glacial ice masked out. (F) Difference map of ​(C)​  and ​(E) 
calculated by taking the absolute value of the difference of the two rasters. Green corresponds to 
agreement between maps while red corresponds to large differences. Black lines are geologic 
contacts as in ​(D). ​ All maps are projected to the WGS 1984 USGS Transantarctic Mountains 
coordinate system 

 
 
 
 
 
 
 



 

Table 2. Statistics for difference values contained in each glacial          
till unit 

 Min Max Mean Std 

Ross Sea  
Drift 0.00 6.00 0.28 0.65 

Undifferentia
ted 0.00 6.00 0.30 0.48 

Taylor-II 0.00 6.00 0.93 0.65 

Taylor-III 0.00 5.00 0.96 0.72 

Taylor-IV 0.00 6.00 1.64 0.92 

Alpine-III 0.00 6.00 2.99 0.82 

Old Alpine or   
Non-till 0.00 6.00 2.73 1.36 

 

 
Figure 13. ​Histogram showing the mean and standard deviation of difference           
values calculated for individual till polygon boundaries.  

 
4. Discussion 
 



 

Can the spatial extent of Bockheim’s mapped glacial deposit units be independently predicted using              
only DEM-derived elevation data? The results achieved by this study suggests that even rudimentary              
analyses can produce promising results. Bockheim 2008 classified soils based on relative age, texture,              
structure, and salt-content. With elevation data and a roughness calculation based on a single              
parameter, the proxy map produced units which correlated surprisingly well with Bockheim’s. Of             
the seven till units examined, three were predicted with a mean error of less than 1 (Figure 13). Even                   
the least-well predicted unit, Alpine-III, was still calculated with an error of 3, which is better than                 
50% accuracy (3.5/7).  
 

If the results of this study are taken to meaningful, they indicate that the distribution of till                 
units in Taylor Valley is largely controlled by elevation. This result is reasonable for till units                
deposited by subsequent glaciation events. Without significant fluvial activity or biotic disturbance,            
there are few landscape processes within Taylor Valley capable of performing geomorphic work to              
displace sediments from where they are initially deposited besides cross-cutting glaciation events.            
Indeed, the DEM on it’s own correlates well with the mapped units. 
 

Intriguingly, performing a surface roughness calculation improved the proxy map. Surface           
roughness may be capturing the geomorphic results of cryoturbation and periglacial processes,            
which may produce diagnostic landforms differentially across the valley and and across till units. It is                
perhaps possible that the textural differences between tills used by Bockenheim to categorize till              
units might also be expressed at the local-relief scale and captured by the roughness calculation. If                
this is the case, then it makes sense that differences in surface roughness would correspond to                
mapped till units. Of course, it is just as possible that the STD​elev calculation is actually capturing the                  
locations of slopes within the valley, which would correspond to till boundaries, but for the same                
reason that elevation does. In this case, the roughness calculation is providing little additional              
information. 
 

The proxy map works best for the largest and lowest elevation units, and seems to be less                 
accurate for predicting the extent of higher elevation units. This pattern may be caused by               
over-calculated roughness values on steep slopes combined with the accumulation of errors            
introduced by inaccurately digitizing the more irregular geologic contacts which exist on the valley              
walls. It is reasonable to expect that the predictive power of the proxy map decreases with increasing                 
surface complexity. 
 
5. Conclusions and Future work 
 
As a region which has been subjected to intense glaciation and whose geomorphology is sensitive to                
small changes in landscape properties (climate, hydrology, topography), study of the surface geology             
of the MDV allows for profound insights into the long-term and short-term geologic history              



 

experienced by these rocky oases. This study suggests that even relatively simple surface analyses              
using high-resolution remote-sensing have significant potential for parsing the evolution of MDV            
landscapes. With elevation data and surface roughness calculations, this study was able to recreate              
the spatial extent of till units mapped based on age, texture, and the presence of ice and salt to                   
considerable effect. 
 

This study was limited by time and disk-space. With more of each, other surface roughness               
calculations might have been employed. STD​slope might provide more meaningful results by ignoring             
the effects of steep slopes. Methods similar to those utilized by this study could be tested in other                  
nearby valleys. 
 

With more sophisticated and directed terrain analyses, it is possible that an algorithm could              
be developed which has the capability to swiftly map any part of the Dry Valleys which contains                 
sufficiently high-resolution LiDAR data with minimal user input. With remote-sensed data alone,            
much might be discovered about the most remote and inhospitable continent on Earth - from               
thousands of miles away. 
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7. Methods Figures 
 

 
Figure 3. ​Georeferencing Bockheim 2008 glacial deposits map PNG image using a LIMA tile of 
the McMurdo Dry Valleys. ​(A)​ Unreferenced PNG image overlaying LIMA tile 
x+0300000y-1350000​. ​(B) ​Control points and links table used to georeference map image. 6 
control points with an RMS error of 63.7 were used. The Georefferenced map was rectified using 
Nearest Neighbor. 

 
 



 

 
Figure 4. ​Creation of a ‘Unit_Name’ domain to contain codes for naming 
glacial deposits. 

 
 



 

Figure 5. ​Topology errors (A) and corrected topology (B) for digitized unit contacts. 

 
 
 



 

Figure 6. ​Digitized glacial deposit, lake, and glacier polygons overlaid atop a georeferenced image 
of a map by Bockheim et al 2008 and a LIMA tile of Taylor Valley. Units were tentatively 
symbolized in blue for clarity. 

 
 
 



 

Figure 7. ​Extent of original (A) and clipped (B) 2014 DEM layer. Blue 
polygon outlines extent of study area and was used as the clipping mask. 

 
 
 



 

Figure 8. ​Inputs used to calculate standard deviation of elevation (STD​elev​) raster from digital 
elevation model raster. A 3 m by 3 m window was chosen to capture changes in local features. 

 
 
 
 



 

Figure 14. ​Raster Calculator operation to derive a quantitative comparison between the spatial 
distribution of elevation + roughness and glacial deposit units. The absolute value of the 
difference allows higher values in the new raster to correspond to greater differences between the 
input rasters.  

 


